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Printer Specifications

Printing

Printing method On-demand ink jet

Nozzle 
configuration Monochrome (black) 64 nozzles 

(32 × 2 staggered)
Color (cyan, magenta, yellow) 
32 nozzles × 3

Printable columns and printing speeds

 Raster graphics mode

ips = inches per second

Character mode

cps = characters per second

Resolution Maximum 1440 dpi × 720 dpi

Print direction Bidirectional with logic seeking for text 
and graphics. (Auto print direction can be 
set in the default-setting mode.)

Control codes ESC/P 2™ and expanded raster graphics 
codes

Line spacing 1/6 inch, 1/8 inch, or programmable in 
1/360-inch increments

Paper feed speed 66.6 milliseconds per 1/6-inch line 

Input buffer 32KB

Fonts

Bitmap fonts

Select other font/pitch combinations using ESC/P 2 commands.

Scalable fonts

Each font has four variations: normal, bold, italic, and bold italic.

edge 
guides

paper support extension

paper support

printer cover

control 
panel

output 
tray 

output tray 
extensions

ink cartridge 
clamp

paper 
out light

paper 
thickness 
lever

load/eject 
button

black 
ink out 
light

color 
ink out 
light

cleaning
 button

power 
button

Print quality Printable area Available dots CR speed

180 dpi 8.26 inches 1488 20 ips

360 dpi 8.26 inches 2976 20 ips

720 dpi 8.26 inches 5952 20 ips

Character pitch 

(characters per inch)

Print 

columns

Draft 

speed

LQ printing 

speed

10 80 400 cps 200 cps

12 96 480 cps 240 cps

15 120 600 cps 300 cps

17 (10 condensed) 137 684 cps 342 cps

20 (12 condensed) 160 800 cps 400 cps

Font 10 cpi 12 cpi 15 cpi Proportional

EPSON Roman x x x x

EPSON Sans Serif x x x x

EPSON Courier x x x

EPSON Prestige x x x

EPSON Script x x x

Font

Minimum 

point size

Maximum 

point size Increments

EPSON Roman 8 32 2

EPSON Sans Serif 8 32 2

EPSON Roman T 8 32 2

EPSON Sans Serif H 8 32 2
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Character tables These character tables are selected with 
the default-setting mode (see page 5 for 
instructions) or by using software 
commands.

❏PC437 (U.S./Standard Europe)
❏PC850 (Multilingual)
❏PC860 (Portuguese) 
❏PC861 (Icelandic)
❏PC863 (Canadian-French)
❏PC865 (Nordic)
❏Abicomp
❏BRASCII
❏Roman 8
❏ISO Latin 1
❏Italic

Character sets 14 international character sets and 1 legal 
character set

Paper 

Note: 
Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, EPSON cannot attest to 
the quality of any non-EPSON brand or type of paper. Always test samples of paper stock before purchasing large quantities or 
printing large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you encounter problems, switch to a higher 
grade of paper.

Do not load curled or folded paper.

Ink jet paper, envelopes, glossy film, glossy paper, and transparencies are usable only under normal conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

EPSON Photo Quality Glossy Paper and Photo Quality Self Adhesive Sheets should be stored under the following conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Paper type Size Paper types Thickness Weight

Single sheets Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)
Legal (8.5 × 14 inches) 
Statement (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)

Plain bond paper and special 
ink jet papers distributed by 
EPSON

0.003 to 0.004 inch (0.08 to 0.11 mm) 17 to 24 lb 
(64 to 90 g/m2)

Transparencies, 
Glossy film, 
Glossy paper

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy film only)

Transparencies, glossy paper, 
and glossy film distributed by 
EPSON

Glossy film and transparencies: 
0.005 to 0.006 inch (0.13 to 0.15 mm)
glossy paper:
0.0066 to 0.0070 inch (0.17 to 0.18 mm)

Adhesive sheets A4 (210 × 297 mm) Self adhesive sheets 
distributed by EPSON

Envelopes No. 109.5 × 4.1 inches (240 × 104 mm) 
DL8.7 × 4.3 inches (220 × 110 mm) 
C64.4 × 6.4 inches (114 × 162 mm)

Plain bond paper or air mail 
paper

0.006 to 0.017 inch (0.16 to 0.43 mm) 12 to 20 lb 
(45 to 75 g/m2)

Index cards A6 (105 × 148 mm)
5 × 8 inches (127 × 203 mm)
10 × 8 inches (254 × 203 mm)

Ink jet cards distributed by 
EPSON

0.0091 inch (0.23 mm) 50.7 lb 
(188 g/m2)
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Printable area

A: The minimum top margin is 0.12 inch (3.0 mm).
When loading multiple sheets of EPSON Photo Quality Glossy 
Film, the minimum top margin is 1.2 inches (30 mm).

B–L: The minimum left margin is 0.12 inch (3.0 mm).
B–R: The minimum right margin for single sheet paper is 0.12 inch 

(3.0 mm) except for letter and legal size paper. The minimum right 
margin for letter and legal size paper is 0.35 inch (9.0 mm).

The minimum right margin for envelopes is as follows:
0.28 inch (7 mm) for DL envelopes.
1.10 inches (28 mm) for No. 10 envelopes.
0.12 inch (3 mm) for C6 envelopes.

C: The minimum bottom margin is 0.54 inch (14.0 mm).

Note:
Always load paper into the sheet feeder short edge first. 
However, envelopes should be loaded long edge first.

Ink Cartridge

* The print capacity may vary, depending on how often you use the 
print head cleaning function.

** It thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution:
To ensure good results, use genuine EPSON ink 
cartridges. Other products may cause damage to your 
printer not covered by EPSON’s warranty.

Don’t use an ink cartridge if the date on the package 
has expired.

A

B-L
B-R

C

A

B-R

C
B-L

Envelope

Single sheet

Specification Black ink cartridge (S020093) Color ink cartridge (S020089)

Color(s) Black Cyan, Magenta, and Yellow

Print capacity* 540 pages/A4 (ISO/IEC 10561 Letter Pattern at 360 dpi) 300 pages (A4, 360 dpi, 5% duty each color)

Cartridge life 2 years from production date (if unopened)
(within 6 months after opening package, at 77 °F (25 °C))

Storage temperature –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit temperature –22 to 140 °F (–30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing temperature** 3.2 °F (–16 °C) –0.4 °F (–18 °C)

Dimensions 0.7 (W) × 2.1(D) × 1.5 (H) inches
19.8 (W) × 52.7(D) × 38.5 (H) mm

1.7 (W) × 2.1(D) × 1.5 (H) inches
42.9 (W) × 52.7 (D) × 38.5 (H) mm
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Mechanical

Paper feed method Friction

Paper path Sheet feeder, rear entry

Sheet feeder 
capacity 100 sheets at 17 lb (64 g/m2) paper

Total print volume 75,000 pages (A4, Text)

Dimensions

Storage Width: 16.9 inches (429 mm) 
Depth: 10.8 inches (275 mm) 
Height: 6.6 inches (168 mm)

Printing Width: 16.9 inches (429 mm) 
Depth: 24.1 inches (613 mm) 

27.4 inches (695 mm) when 
printing transparencies

Height: 12.2 inches (309 mm)
7.7 inches (196 mm) when 
printing transparencies

Weight 11.5 lb (5.2 kg) without the ink cartridges

Electrical

Note: 
Check the label on the back of the printer for the voltage 
of your printer.

Environmental

Temperature Operation: 50 to 95 °F (10 to 35 °C)
Storage:–4 to 140 °F (–20 to 60 °C), 

stored in shipping container 
1 month at 104 °F (40 °C) 
120 hours at 60 °C (140 °F)

Humidity Operation: 20 to 80% RH
Storage: 5 to 85% RH (stored in shipping

container, without condensation)

Safety Approvals

Safety standards UL 1950 with D3, CSA C22.2 No.950 
with D3

EMC FCC part 15 subpart B class B, 
CSA C108.8 class B

Interface

Your printer is equipped with an 8-bit parallel interface and a 
serial interface.

Parallel interface

The built-in parallel interface has the following characteristics:

Forward channel

Data format 8-bit parallel, IEEE-1284 compatibility
 mode

Synchronization STROBE pulse

Handshake timing BUSY and ACKNLG signals

Signal level TTL compatible

Connector 57-30360 Amphenol connector or 
equivalent

Reverse channel

Transmission mode IEEE-1284 nibble mode

Adaptable 
connector 57-30360 Amphenol connector or 

equivalent

Synchronization Refer to the IEEE-1284 specification

Handshaking Refer to the IEEE-1284 specification

Signal level IEEE-1284 Level 1 device

Data transmission 
timing Refer to the IEEE-1284 specification

Serial interface

The printer’s built-in serial interface is based on the RS-423 
standard. This interface has the following characteristics: 

Standard Based on RS-423

Synchronization Synchronous

Bit rate Approx. 900 Kbps

Handshaking X-ON/X-OFF DTR protocol

Word format Data bit: 8 bits
Parity bit: None
Start bit: 1 bit
Stop bit: 1 bit

Connector 8-pin mini-circular connector

Recommended 
cable Apple System Peripheral-8 cable 

(Part number M0197)

Specification 120V Model 220−240V Model

Input voltage range 103.5 to 132V 198 to 264V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4A 0.2A

Power consumption Approx. 15W (ISO/IEC 10561 Letter Pattern)
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Initialization

The printer can be initialized (returned to a fixed set of 
conditions) in these ways:

Hardware initialization

When the printer is turned on, the printer mechanism is 
initialized, the input and print buffers are cleared, and all 
settings return to their default values. However, the printer 
mechanism is not initialized if the printer is turned on within 
10 seconds after being turned off. In this case, the printer caps 
the print head, and ejects any paper in the paper path.

Software initialization

Software initialization clears the print buffer and returns all 
settings to their default values, as shown below.

Default Settings

The table below shows the default settings that take effect 
when the printer is initialized.

Built-in Fonts and Character Tables

Your printer has eight built-in fonts and eleven character 
tables that you can select using the printer’s default-setting 
mode as described below. The setting you choose takes effect 
each time you turn on the printer. Available fonts and 
character tables are listed on pages 1 and 2.

Note: 
The font and character table selections you make with 
your software override the settings you make using the 
default-setting mode. For best results, use your 
software to make these settings.

To change the default font or character table, follow these 
steps:

1. Make sure the printer is turned off and paper is loaded in 
the sheet feeder. (Use paper at least 8.2 inches wide. 
Otherwise the print heads will spray ink directly onto the 
platen.)

2. Hold down the R cleaning button and turn on the printer.

The printer loads a sheet of paper and prints a brief 
summary and instructions.

3. Follow the instructions on the sheet and press the 
R cleaning button until the control panel lights indicate 
the language of your choice.

4. Press the E load/eject button to print the default font and 
character table and the next page of instructions.

The instruction sheet lists all of the fonts and character 
tables you can select. 

5. Select the font and character table you want to use. 

6. Exit the default setting mode by turning off the printer.

If you want to check the current default font and character 
table, enter the default setting mode again and print the 
current settings, which are indicated by arrows. 

Note: 
You may exit default setting mode any time by turning 
off the printer. Any changes you made remain in effect 
until you change them again.

Hardware 
initialization

∗ The printer is turned on.
∗ The printer receives an INIT signal from the parallel 
interface.

Software 
initialization

∗ Software sends the ESC @ (initialize the printer) 
command. The last panel settings are kept.

Item Default Setting

Top-of-form position Current paper position

Page length Single sheets: 22 inches

Left and right margins Cancelled

Line spacing 1/6-inch line spacing

Character pitch Last font selected using default-setting mode

Vertical tab position Cleared

Horizontal tab 
positions

Every eight characters

Font selection Last font selected using default-setting mode

Special printing effects Cancelled (except condensed and economy 
printing)

User-defined 
character set

Hardware/control panel initialization: cleared
Software initialization: deselected only
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Control Panel 

The four lights on your printer’s control panel show the 
printer’s status and alert you to problems like paper jams. 

Using the Control Panel Buttons

Follow these guidelines when using the control panel buttons:

Installing an Ink Cartridge for the First 
Time

1. Lower the output tray and raise the printer cover.

2. Press the Ppower button to turn on the printer. The 
Ppower light flashes, the B and A ink out lights come on, 
and the ink cartridge holders move to the installation 
position.

3. Pull up the ink cartridge clamps.

S When the paper light comes on, your paper 
ran out or is incorrectly loaded. Load paper 
in the feeder and then press the E load/eject 
button. 

B A When an ink light comes on, you need to 
replace the ink cartridge. See page 14.

B A When an ink light flashes, your ink supply is 
low. Make sure you have a replacement 
cartridge.

S B A When the paper light flashes and the ink out 
lights are on, you have a paper jam. Turn off 
the printer and gently pull out all jammed 
paper. Reload the paper, then press the E 
load/eject button. 

P The power light is on when the printer is on. 
The power light flashes when the printer is 
receiving data or charging ink, or if you are 
replacing an ink cartridge or cleaning a print 
head.

P S B A When the power and paper lights flash and 
the ink out lights are on, your printer has a 
carriage error. Press the P button twice to 
reset the printer. 

P S B A When all the lights flash, your printer may 
have an internal error. 

P Turns the printer on and off.

Resets the printer (clears its memory) if pressed 
twice within 10 seconds while the power is on.

E Loads or ejects paper if pressed and released within 
two seconds. Resumes printing if pressed after a 
paper out error is corrected.

R Moves the print head to the replacement position if 
pressed for about three seconds while the B or A 
ink out light is flashing or on. Returns the print 
head to its home position after ink cartridge 
replacement.

Performs print head cleaning if pressed for about 
three seconds when the B or A ink out light is off.
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4. Open the ink cartridge packages. Remove the disposable 
yellow portion of the tape seal on top.

Caution:
You must remove the tape seal from the top of the 
cartridge or you will permanently damage it. Don’t 
remove the tape seal from the bottom or ink will leak.

Warning:
If ink gets on your hands, wash them thoroughly with 
soap and water. If ink gets in your eyes, flush them 
immediately with water.

5. Lower the ink cartridges into their holders with the labels 
face up and the arrows pointing toward the back of the 
printer.

6. Push down the clamps until they lock in place.

7. Press the R cleaning button to return the print heads to 
their home position and charge the ink delivery system. 
Charging can take up to five minutes, with the Ppower 
light flashing until its finished.

Caution:
Never turn off the printer when the Ppower light is 
flashing.

8. Close the printer cover.

Loading Paper

1. Slide the left edge guide all the way left and pull out the 
output tray extension.

2. Fan a stack of plain paper and then even the edges.

3. Load the stack like this with the printable surface face up. 
Push the paper against the right edge guide.

Note:
Don’t load paper above the arrow mark inside the left 
edge guide.

4. Slide the left edge guide back against the stack of paper.

Testing the Printer

You can run a printer check to determine whether the 
problem comes from the printer itself or the computer. 

❏ If the results are satisfactory, the problem lies in software 
settings, the interface cable, or your computer.

❏ If the printer check does not print correctly, you have a 
problem with your printer. 

Follow these steps to check the printer:

1. Make sure both the printer and computer are turned off.

2. Disconnect the interface cable from the printer.
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3. Make sure paper is loaded in the printer.

Caution:
Use paper that’s at least 8.2 inches wide. Otherwise 
the print head will spray ink directly onto the platen.

4. Hold down the E load/eject button and press the Ppower 
button to turn on the printer. Then release both buttons.

The printer prints one page containing the printer’s ROM 
version, page count code, and a nozzle check pattern. The 
following sample is in black and white, but the actual 
printout is in color.

W0186 02BB

5. After it prints the page, turn off the printer. Remember to 
reconnect the interface cable, then turn on the printer and 
your computer.

Printing from Windows

When you want to print from your Windows application, you 
click the print icon or choose Print from the File menu. You 
can then choose which pages to print, the number of copies, 
and other options. The settings that describe your print job—
whether you want to use color or black ink, for example—are 
part of your printer driver software. 

Setting Printer Options from Windows 
Applications

This section describes the preferences you’ll need to set for all 
your everyday printouts. 

Note:
The settings you select through your Windows 
application apply only until you exit that application. Then 
the driver settings return to the driver’s default values or 
the values selected through the Windows 95 Printer 
Properties or Windows 3.1 Control Panel.

Follow these steps to check printer settings from your word 
processor or other Windows software:

1. Click the print icon or choose Print or Print Setup from 
the File menu. You see a printing dialog box.

If you choose Print, you first see a Print dialog box that 
contains the settings you change most often, including the 
number of copies and the pages you want printed. 

2. Make sure your EPSON Stylus COLOR 600 printer is 
selected, and then click the Printer, Setup, Properties, or 
Options button. (You may have to click a combination of 
these buttons.) You see a dialog box like the following:

3. If you do not see the dialog box shown in step 2, click the 
Main tab.

4. Make sure the Mode option is set to Automatic. The 
printer software determines the best settings according to 
the Media Type and Ink settings you make. This is the 
easiest way to get good printing results for all kinds of 
documents, on all types of paper.

5. Choose the Media Type you want to print on from the 
following list (you may need to scroll through the list). If 
you are not sure which setting to select for your media, refer 
to the table on page 16.

❏ Plain paper

❏ 360 dpi Ink Jet Paper

❏ Photo Quality Ink Jet Paper

❏ Photo Quality Glossy Paper

❏ Photo Quality Glossy Film

❏ Ink Jet Transparencies

The type of media you choose determines the print quality 
or resolution you can use. 

Note:
For printing at the highest resolution (SuperFine 
quality at 1440 dpi), you need to use one of the 
photo quality media. For the best printing at any 
resolution, always use EPSON media.

6. Choose Color or Black ink. If you are printing black text, a 
draft, or if you want colors to print as varying shades of 
gray, select Black for faster printing.

Main tab
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7. Set the slider to Quality or Speed. This lets you choose 
between the highest resolution or the fastest printing for the 
media you’re using. (The slider is not available for certain 
media types.)

Once you’ve changed these basic settings as needed, check 
the Current Settings box on the bottom of the menu to see 
if the other settings are correct for your document. If you 
need to adjust them, use Advanced mode.

8. If necessary, click the Paper tab and choose your paper size, 
number of copies, orientation, and printable area. If your 
software application lets you control these settings, you 
don’t need to use the Paper tab.

Note:
To cancel your changes and exit the driver, click the 
Cancel button at the bottom of the menu at any time.

9. Click OK when you’re finished checking your settings. The 
dialog box closes.

10. In the printing dialog box, click Close, OK or Print. You 
may need to click a combination of these buttons.

While your document is printing, the EPSON Despooler 
dialog box appears, showing the printing progress and the 
status of your printer. If you’re using Windows 95, this box 
also displays the Status Monitor. (See “Using the 
Despooler” on page 12 for more information.)

Setting Default Printer Options

When you change printer settings through your software 
application, the settings apply only to the application you’re 
using. If you want to adjust the default settings for all your 
Windows applications, you can access the dialog box through 
the Windows 95 Settings option or the Windows 3.1 Control 
Panel. 

Make sure all your software applications are closed before you 
start. If not, you’ll have to close and then reopen them to have 
the new default settings take effect.

Note:
The settings you select using Windows apply to all your 
Windows applications, unless you change them for a 
particular application session, as described above. Also 
some application settings override driver settings (such 
as Paper Size or Orientation), so it’s a good idea to check 
the driver settings in your application too.

Setting Default Options in Windows 95

Follow these steps: 

1. Click Start, point to Settings, and then point to Printers. 

2. Right-click the EPSON Stylus COLOR 600 icon. 

3. Select Properties. Then click the Main tab. 

You see the Main printer settings dialog box, as shown on 
page 8. 

4. Change the settings you want and click OK. 

Any changes you make will become the default settings for 
all your applications and documents. 

Setting Default Options in Windows 3.1 

Follow these steps: 

1. Double-click the Control Panel icon in the Main group. 

2. Double-click the Printers icon. 

3. Select EPSON Stylus COLOR 600 from the list of printers 
and click Setup. 

You see the Main printer settings dialog box, as shown on 
page 8. 

4. Change the settings you want and click OK. 

Any changes you make will become the default settings for 
all your applications and documents. 

Printing from a Macintosh

Follow these steps to check printer settings from your word 
processor or other Macintosh software:

1. Choose Page Setup from the File menu. You see the Page 
Setup dialog box.

2. Choose your paper size and other page setup options and 
click OK.

3. Choose Print from the File menu or click the print icon in 
your application. You see a dialog box like the following:

Note:
On the Macintosh, printer settings are saved with your 
document, but you can’t save them from one application 
to another. You’ll have to check your settings each time 
you print from a new application. If you want to reuse 
settings, you can create document templates for your 
favorite applications.

Click to see list 
of media types
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4. Choose the number of copies and indicate which pages you 
want to print.

5. Make sure the Mode option is set to Automatic. The 
printer software determines the best settings according to 
the Media Type and Ink settings you make. This is the 
easiest way to get good printing results for all kinds of 
documents, on all types of paper.

Choose the Media Type you want to print on from the 
following list. The type of media you choose determines the 
print quality or resolution you can use. If you are not sure 
which setting to select, refer the table on page 16.

❏ Plain Paper

❏ 360 dpi Ink Jet Paper

❏ Photo Quality Ink Jet Paper

❏ Photo Quality Glossy Paper

❏ Photo Quality Glossy Film

❏ Ink Jet Transparencies

Note:
For printing at the highest resolution (SuperFine 
quality at 1440 dpi), you need to use one of the 
photo quality media. For the best printing at any 
resolution, always use EPSON media.

6. Choose Color or Black ink. If you are printing black text, a 
draft, or if you want colors to print as varying shades of 
gray, choose Black for faster printing.

7. Set the slider to Quality or Speed. This lets you choose 
between the highest resolution or fastest printing for the 
media you’re using. 

8. Click Print when you’re finished checking your settings. 

If you chose background printing when you set up your 
printer, you can continue working while your document is 
printing.

Printing from DOS

Most DOS software programs include software for EPSON 
ESC/P 2 printers. You need to select the correct printer 
software to take advantage of your printer’s advanced built-in 
scalable fonts and graphics handling.

Most DOS programs require you to select from a list of 
printers to install the printer software. If EPSON Stylus 
COLOR 600 is not included in the list, contact your software 
manufacturer to obtain updated software. 

If updated software is not available, pick the first printer 
available in the lists below.

Note:
The drivers for the printers listed do not provide all 
EPSON Stylus COLOR 600 features, such as 1440-dpi 
printing, 720-dpi printing, and MicroWeave.

When printing black and color, select:

EPSON Stylus Pro
EPSON Stylus COLOR 500
EPSON Stylus COLOR II
LQ-860
LQ-2550

When printing black only, select:

LQ-870/1170
LQ-500
LQ-570(+)/1070(+)
SQ-870/1070
LQ-850

Managing Print Jobs in Windows

Your Windows printer software includes two management 
utilities: the Spool Manager and Status Monitor. 

❏ The Spool Manager starts automatically when you send a 
job to the printer. It allows you to print in the background 
while you continue to work on your computer and to hold 
jobs to print at a later time. If you’re using your printer on a 
network, it also handles multiple print jobs that come in at 
the same time.

❏ The Status Monitor, which is available only if you’re using 
Windows 95, also starts automatically when you send a job 
to the printer. It displays on your screen to alert you about 
printer and ink status. 

Note:
The Status Monitor doesn’t appear if you’re printing over 
a network.

Using the Spool Manager

The Spool Manager works like the Windows Print Manager. 
When you send a job to your printer, your printer software 
creates a temporary journal file, stores it in the C:\TEMP or 
C:\WINDOWS\TEMP folder or directory, and assigns it to a 
print queue. The software then sends the file to your printer at 
the right time.

❏ To open the Spool Manager while you’re printing, click 
the Spool Manager icon that appears on the Taskbar 
(Windows 95) or at the bottom of your desktop 
(Windows 3.1). 
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Note:
In Windows 3.1, you may not see the Spool Manager 
icon if the Program Manager or current window is 
maximized. Make the window smaller to see the Spool 
Manager icon. 

❏ To open it at any time, double-click the Spool Manager4 
icon in the EPSON program group or folder.

You see the Spool Manager window:

The Spool Manager window displays the status of your print 
queues and journal files and lets you control them. Here are 
some of the things you can do:

❏ Hold or release a queue

❏ Send journal files to your printer over a network 

❏ Hold, re-queue, or delete a journal file

❏ Select the information you want to see in the Spool 
Manager window

❏ Prevent the Despooler popup window from appearing on 
your screen whenever you print

❏ Change your default spool directory

Deleting a Stalled Print Job

If you’re having trouble printing, it may be because of a stalled 
print job. Follow these steps to delete it so you can continue 
printing:

1. Open the Spool Manager as described on page 10.

2. Click on any print jobs marked Held, then open the 
Document menu and click Delete. 

3. Click Yes.

4. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message when you try to print, or printing 
is very slow, you can try changing your default spool directory. 
Follow these steps:

1. Make a directory on your hard disk where you want Spool 
Manager to store journal files, for example, C:\SPLTEMP.

2. Open the Spool Manager.

3. Choose Default Spool Directory from the Options menu. 

4. In the dialog box, change the spool directory to the one you 
created in step 1. Then click OK.

5. Make sure EPSON Stylus COLOR 600 is selected, and 
then choose Setup from the Queue menu. The Queue 
Setup dialog box appears.

6. Make sure the spool directory is the one you created in 
step 1. Also make sure Use Print Manager for this port is 
checked. Then click OK. (If you are using Windows 95 and 
don’t see the Status Monitor when you print, make sure it’s 
unchecked.)

7. Close Spool Manager.

Using the Status Monitor

The Status Monitor, available only if you’re using 
Windows 95, displays automatically when you send a job to 
the printer. However, you can use it at any time to see how 
much ink you have left. Follow these steps:

1. Access the Main printer settings dialog box.

2. Click the Utility tab. You see the Utility menu.

3. Click the EPSON Status Monitor icon.You see the 
Despooler window with the Status Monitor at the bottom:

4. Check the amount of ink you have left. For more 
information about the Despooler window, see the 
following sections.

menus

journal file
queue
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Using the Despooler

While your document is printing, the EPSON Despooler 
dialog box appears on your screen:

Note:
If you don’t want the Despooler dialog box to appear 
each time you print, you can turn it off. To do this, start 
Spool Manager, open the View menu, and select Show 
Despool Popup; the checkmark next to the option 
disappears.

This dialog box shows the progress of your print job and the 
status of your printer. If you run out of paper while printing, 
for example, the Despooler warns you. You can use the 
buttons to cancel, pause, or restart your print job. 

The Status Monitor at the bottom of the dialog box shows 
how much ink is left in your printer, along with these status 
icons:

Note:
The Status Monitor appears only if you’re using 
Windows 95 and you’re not printing over a network.

Managing Print Jobs on a Macintosh

Your Macintosh printer software includes two management 
utilities: Monitor2 and Status Monitor. 

❏ If you’re using background printing, Monitor2 starts 
automatically when you send a job to the printer. It handles 
printing while you continue to work on your Macintosh 
and lets you track documents that are waiting to be printed. 

❏ The Status Monitor alerts you to any problems that occur 
during printing. You can also use it at any time to see how 
much ink you have left. 

Using Monitor2

The Monitor2 utility lets you continue to work on your 
Macintosh while your document is printing. However, 
background printing is slower and may also slow down your 
system. 

If you want to use this utility, you need to turn on 
background printing in the Chooser and increase the memory 
allocation for Monitor2. Follow these steps:

1. Open the Chooser from the Apple menu and select the 
EPSON Stylus(EX) icon. Then click either the printer or 
modem icon.

2. Under Background Printing, click On and close the 
Chooser.

3. To increase the memory allocated to Monitor2, select 
EPSON Monitor2 in the Extensions folder in your System 
folder.

4. Choose Get Info from the file menu.

5. Set the Memory Requirements to 2000K or 3000K, 
depending on your system’s available RAM.

6. While you’re printing, click the EPSON Monitor2 icon on 
the Application menu at the right end of the menu bar. You 
see a dialog box like the following:

7. You can select a job and cancel it or just use this window to 
track the printer’s progress.

Checking the printer status.

A printing error has occurred and your 
printer cannot print. Check your printer.

The printer is ready to print.

The printer is currently printing.

The ink level is low or empty; check the B 
or A ink out light on the control panel and 
replace the cartridge if necessary.

The name of 
the file you’re 
printing 
appears here

Click to 
pause 
printing

Click to 
cancel 
printing

Click to 
restart 
printing

job currently 
printing

jobs queued 
for printing 
would appear 
here
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Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in 
your printer and to control the way your software warns you 
about printer problems. Follow these steps:

1. Choose Print from the File menu or click the Print button 
in your application. You see the printer settings dialog box.

2. Click the Utility button. You see the Utility menu.

3. Click the Status Monitor icon. The software checks the 
amount of ink remaining in the printer and displays the 
Status Monitor window:

4. If you want to change printer messages and warnings, click 
the Configuration button. 

You see the following dialog box:

5. Choose the options you want and click OK.

Network Printing on a PC

You can use your printer on a network under Windows 95 or 
other network operating systems. The Spool Manager sends 
journal files from your computer to a shared directory on a 
network server. These files can then be printed from another 
computer attached to the printer. 

First you need to install the EPSON Stylus COLOR 600 
printer software on each computer that is going to print on 
the network. Then run Spool Manager and identify the shared 
directory to use for journal files. After you set this up on the 
system connected to the printer, you need to perform a similar 
procedure on each remote system on the network. 

Under Windows 95, you also need to specify the port and 
network path to the printer.

Setting Up Your Journal File Directory

Follow these steps to set up the computer connected to the 
printer and any other computers on the network:

1. On the computer connected to the printer, open the Spool 
Manager window as described on page 10.

2. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

3. Click the Spool to remote printer button.

4. Click the Browse button and select the remote server 
directory that will receive journal files.

5. On remote systems, open the Spool Manager window as 
described on page 10.

6. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

7. Click the Remote Despool tab and then click the Printing 
from remote queues option.

8. Click the Browse button and select the directory you’re 
using for journal files on the remote server (selected in 
step 4).

Setting Up Your Network Path in 
Windows 95

If you want to use your printer on a network running 
Windows 95, you need to set up the port and network path on 
the computer connected to the printer. Follow these steps:

1. Double-click My Computer.

2. Double-click the Printers folder.

3. Right-click the EPSON Stylus COLOR 600 icon and 
choose Properties.

Click to recheck 
ink level

Click to control 
messages and 
warnings
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4. Click the Details tab.

5. Click the Add Port button, then specify the network path 
to the printer and click OK.

6. Open the Spool Manager window as described on page 10.

7. In the Spool Manager window, double-click your printer’s 
queue. The Queue Setup dialog box appears.

8. Make sure the Use Print Manager for this port option is 
checked. Then click OK.

Replacing an Ink Cartridge

When a B black or A color ink out light flashes, the indicated 
cartridge is low on ink. This is a good time to make sure you 
have a new cartridge. When the light stays on, the cartridge is 
empty and you need to replace it.

Use these EPSON ink cartridges within six months of 
installing them and before the expiration date on the package:

Black ink cartridge S020093
Color ink cartridge S020089.

Caution:
For best results, don’t replace an ink cartridge unless 
its ink out light is flashing or on.

If ink runs out, you can’t continue printing, even if ink 
remains in the other cartridge.

To ensure good results, use genuine EPSON 
cartridges and do not refill them. Other products may 
cause damage to your printer not covered by EPSON’s 
warranty.

Removing an Empty Ink Cartridge

You can replace a cartridge when the B black or A color ink 
out light is either flashing or on. Follow these steps:

1. Make sure the printer is turned on and not printing. 

2. Determine which cartridge needs to be replaced.

3. Lower the output tray and raise the printer cover. 

Caution:
If you press the R cleaning button when no ink out 
light is flashing or on, the printer cleans the print 
heads as described on page 18.

If you need to replace an ink cartridge before the lights 
flash (because the ink is too old, for example) follow 
the instructions on page 15.

Leave the old cartridge installed until you are ready to 
replace it with a new one. Attempting to print without 
a cartridge installed can damage your printer.

Once you remove an ink cartridge, it becomes 
unusable and cannot be reinstalled.

4. Press the R cleaning button and hold it for three seconds. 

The print heads move slightly left and the P power light 
begins flashing. (The print heads return to their home 
position if you don’t proceed to step 5 within 60 seconds.)

5. Pull up the ink cartridge clamp. The cartridge rises up from 
its holder. (Although the illustration shows the color ink 
cartridge, the procedure is the same for replacing the black 
ink cartridge.)

6. Lift the cartridge out of the printer and dispose of it 
carefully. 

7. Follow the steps in the next section to install the new ink 
cartridge.

Installing the New Cartridge

Once you have removed the empty cartridge, you’re ready to 
install the new one. Follow these steps:

1. Remove the new ink cartridge from its packaging. 

2. Remove the yellow tape seal as shown:

Caution:
You must remove the tape seal from the top of the 
cartridge; leaving the tape on will permanently 
damage it. Do not remove the clear seal from the 
bottom of the cartridge; ink will leak out.

ink cartridge clamp

black cartridge color cartridge
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Warning:
If ink gets on your hands, wash them thoroughly with 
soap and water. If ink gets into your eyes, flush them 
immediately with water.

3. Lower the ink cartridge into its holder with the label facing 
up and the arrow pointing to the back of the printer. The 
larger cartridge (color) goes on the right, the black ink 
cartridge on the left.

4. Press down the ink cartridge clamp until it locks in place.

Caution:
Don’t open the clamp or remove a cartridge except to 
replace it with a new one. Once you remove a 
cartridge, you can’t reuse it, even if it contains ink.

5. If you need to replace the other ink cartridge, remove it as 
described in “Removing an Empty Ink Cartridge” on
page 14. Then follow steps 1 through 4 in this section.

6. Press the R cleaning button and close the printer cover.

The printer moves the print heads and begins charging the 
ink delivery system. (Even if you don’t press the button, ink 
charging begins 60 seconds after you close the clamp.)

The Ppower light flashes and the printer makes various 
sounds. Charging takes about two minutes. When it’s 
finished, you can print again.

Caution:
Never turn off the printer while the P power light is 
flashing.

Replacing an Outdated Ink Cartridge

If an ink cartridge is more than six months old, you may need 
to replace it. How can you tell? You may notice that your 
printouts don’t look as good as they used to. If print quality 
doesn’t improve after cleaning and aligning the print heads, 
you can replace one or both cartridges.

Follow these steps to replace an ink cartridge before the B 
black or A color ink out light is flashing or on:

1. Make sure the printer is turned on and not printing.

2. Lower the output tray and raise the printer cover. 

3. Press the E load/eject button and hold it down for a few 
seconds until the print heads move to the left.

Caution:
To avoid damaging the printer, never move the print 
heads by hand.

4. Pull up the ink cartridge clamp. The cartridge rises up from 
its holder. 

5. Lift the cartridge out of the printer and dispose of it 
carefully. 

6. Follow the steps in the previous section, “Installing the New 
Cartridge,” to install the new ink cartridge.

Using Special Media

When you print on special media, you need to be careful 
about choosing the correct Media Type and Paper Size 
settings in your printer software. Use the table on the next 
page to help you match the media type you loaded in the 
printer with the Media Type setting in the printer driver.

The type of paper or other media you use is one of the most 
important factors in determining the quality of your printed 
output. For example, you can achieve the highest resolution 
(SuperFine quality at 1440 dpi) only when you use EPSON 
Photo Quality media. The following tips will help you get the 
best results on any type of paper or other media.
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Note:
If the corresponding Media Type option for your paper is 
not shown in the Media Type list, change the Print 
Quality setting in the More Settings dialog box, select 
Automatic as the Mode setting, or change the 
predefined setting in the Advanced settings list on the 
Main menu.

Caution:
Don’t use the cleaning sheets that may be included 
with your special media; they may damage the printer.

Letterhead, Pre-printed Forms, and Legal-
size Paper

Always load the top edge first. If you are loading long paper, 
pull out the paper support extension and both output tray 
extensions. Don’t load it more than half way to the arrow 
mark on the left edge guide.

EPSON 360 dpi, High Quality, and Photo 
Quality Ink Jet Paper

You can load paper up to the arrow mark on the left edge 
guide. If you use legal-size ink jet paper, don’t load it more 
than half way to the arrow mark.

EPSON Photo Quality Glossy Paper, Film, 
and Transparencies

To print on transparencies, remove the paper support and 
reinstall it in the rear paper support slot. For glossy paper and 
film, leave the paper support in the normal position.

Before you load glossy media or transparencies, put a support 
sheet (packed with the media) or a plain paper sheet beneath 
the stack. You can load up to 20 sheets of glossy paper or up to 
30 sheets of glossy film or transparencies. 

However, you may get better results by loading one sheet at a 
time. With multiple sheets loaded, the minimum top margin 
you can use is 1.2 inches. If you want to use a smaller top 
margin, load and print one sheet at a time.

Note:
Use ink jet papers within one year of purchase. Use 
glossy media and transparencies within six months. 
Return unused sheets and envelopes to their original 
package as soon as possible.

Remove each sheet from the output tray immediately after it’s 
printed. Make sure each sheet is dry before stacking it.

For this media name . . .
Select this Media Type 
setting . . .

Plain paper Plain paper

Envelopes Plain paper

EPSON 360 dpi Ink Jet Paper 360 dpi Ink Jet Paper

EPSON Special Coated Paper for 360 dpi 
Printing

EPSON High Quality Ink Jet Paper Photo Quality Ink Jet 
PaperEPSON Photo Quality Ink Jet Paper

EPSON Special Coated Paper for 720 dpi 
Printing

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

EPSON Photo Quality Glossy Paper Photo Quality Glossy 
Paper

EPSON Photo Quality Glossy Film Photo Quality Glossy 
FilmEPSON High Quality Glossy Paper

EPSON Iron-On Transfer Paper

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Envelopes

You can load up to 10 envelopes as shown below:

Note:
Be sure to load the envelope flap edge first and printable 
side up.

If ink smears when you print on envelopes or other thick 
media, set the paper thickness lever to the + position. Open 
the printer cover and position the lever as shown below. Then 
close the cover and print. (Make sure you return the lever to 
the 0 position before you print on thin media.)

 

EPSON Photo Quality Ink Jet Cards

You can use these cards to print photographs that look almost 
as good as the ones you get from film processing. 

You can load up to 30 cards at a time with a support sheet 
(packed with the cards) or a sheet of plain paper beneath the 
stack. When you’re ready to print, use your software to set the 
Paper Size option for the size card you’re using.

If ink smears on the cards, set the adjust lever to the + position 
as shown above.

EPSON Iron-On Transfer Paper

You can print photos, company logos, or anything else you 
want on this paper, and then transfer your images to T-shirts 
or other cloth items. Load one sheet of transfer paper at a 
time. After you print, follow the instructions that came with 
the paper to iron the image onto the shirt or other item.

Tip:
For iron-on transfers, make sure you reverse your image before 
you print it, especially if it includes text. Then the text will read 
correctly when it’s transferred. You can use the Flip Horizontal 
option in your printer software. 

EPSON Photo Quality Self Adhesive 
Sheets

Use these sheets to print labels or stickers. You should load 
these media one sheet at a time. Make sure your adhesive 
sheets are fully adhered to their backing sheet before you load 
them.

Printer Care

Cleaning the Print Heads

If your printed image is unexpectedly light or faint, or dots are 
missing from the image, you may need to clean the print 
heads. This unclogs the nozzles so they can deliver ink 
properly.

Cleaning the print heads uses ink, so clean them only if print 
quality declines. You can use either of the following to clean 
the print heads:

❏ The Head Cleaning utility in your printer software

❏ The printer’s control panel buttons. 

Using the Head Cleaning Utility

Follow these steps to run the utility from a Windows 
computer or a Macintosh:

1. Make sure the printer is turned on but not printing, and the 
B black and A color ink out lights are off.

2. Access the Main printer settings dialog box.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Head Cleaning icon.

5. Follow the instructions on the screen to clean the print 
heads. Cleaning takes about two minutes, during which the 
printer makes some noise and the Ppower light flashes. 
When the Ppower light stops flashing, you need to run a 
nozzle check.
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Caution:
Never turn off the printer while the Ppower light is 
flashing.

6. Make sure paper is loaded in the printer and click Print 
nozzle check pattern (Windows) or Confirmation 
(Macintosh). See the section below for instructions on 
examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above.

Using the Control Panel

1. Make sure the printer is turned on and not printing, and 
that the B black and A color ink out lights are off.

2. Press the R cleaning button and hold it for three seconds. 
Cleaning takes about two minutes, during which the printer 
makes some noise and the Ppower light flashes. 

After the cleaning cycle is complete and the Ppower light 
stops flashing, you need to run a nozzle check. 

3. Access the Main printer settings dialog box.

4. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

5. Click the Nozzle Check icon. See the next section for 
instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look 
something like this, with the lower pattern colored cyan, 
magenta, and yellow:

Each staggered horizontal and straight vertical line should be 
complete, with no gaps in the dot pattern. If your printout 
looks okay, you’re done. If any dots are missing, clean the 
print heads again, as explained in the previous sections.

Aligning the Print Heads

If your printouts contain misaligned vertical lines, you may 
need to align the print heads. Follow these steps:

1. Make sure the printer is turned on and paper is loaded.

2. Access the Main printer settings dialog box.

Caution:
Load paper that’s at least 8.3 inches wide so ink 
doesn’t spray onto the platen.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment icon.

5. Follow the instructions on the screen to print a test page 
and select the correct alignment.

Cleaning the Printer

To keep your printer working at its best, you should clean it 
several times a year, following these steps:

1. Turn off the printer, unplug the power cord, and 
disconnect the printer cable.

Caution:
Don’t touch the gears inside the printer.

Never use alcohol or thinner for cleaning; they can 
damage the printer components and case.

Don’t use a hard or abrasive brush.

Don’t get water on the printer components.

Don’t spray lubricants or oils inside the printer.

2. Remove all the paper from the sheet feeder.

3. Carefully clean away dust and dirt with a soft, damp cloth.

4. Clean the exterior of the printer with a soft, damp cloth. 
Keep the printer cover closed so water doesn’t get inside.

5. Clean ink out of the printer’s interior with a soft, damp 
cloth.

Information Reference List

Engineering Change Notices None

Product Support Bulletins None

Technical Information Bulletins None

Related Documentation

TM-STYCLR600 EPSON Stylus COLOR 600 Service 
Manual

PL-STYCLR600 EPSON Stylus COLOR 600 Parts Price 
List

4006673 EPSON Stylus COLOR 600 User’s Guide

4006672 EPSON Stylus COLOR 600 Quick Setup 
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